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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP ProBook 4740s Notebook PC

Processors Intel® Core™ i7 processor, Quad Core (6-MB L3 cache, 35W)

 3612QM, 2.10-GHz processor

 Intel® Core i5 processors, Dual Core (3-MB L3 cache, 35W)

 3360M, 2.80-GHz processor

 3320M, 2.60-GHz processor

 2450M, 2.50-GHz processor

 Intel Core i3 processors, Dual Core, 3rd generation (3-MB L3 cache, 35W)

 3110M, 2.40-GHz processor

 Intel Core i3 processors, Dual Core, 2nd generation (3-MB L3 cache, 35W)

 2370M, 2.40-GHz processor

 2350M, 2.30-GHz processor

 Intel Pentium processor, Dual Core (2-MB L3 cache, 35W)

 B980, 2.40-GHz processor

 B970, 2.30-GHz processor

 Intel Celeron processor (2-MB L3 cache, 35W)

 B840, 1.90-GHz processor

Chipset Mobile Intel HM76 chipset

Graphics AMD Radeon™ HD 7650M, 1-GB or 2-GB (discrete)

Panel All display assemblies include 2 wireless local area network (WLAN) antennas

All displays are LED backlit

 43.9-cm (17.3-inch) HD+, 1600x900, includes camera

Memory Two customer-accessible/upgradeable memory module slots supporting up to 8 GB
of RAM

 Supports dual-channel memory

 PC3-10600, 1333-MHz, DDR3
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Category Description

 Supports the following configurations:

● 8192 (4096 × 2)

● 6144 (4096 + 2048)

● 4096 (2048 × 2)

● 4096 (4096 × 1)

● 2048 (2048 × 1)

Hard drives Supports 7-mm/9.5-mm/12.7-mm, 2.5-in SATA hard drives with HP 3D DriveGuard

 Customer-accessible

 Supports the following drives:

● 750-GB, 7200-rpm and 5400-rpm

● 640-GB, 5400-rpm

● 500-GB, 7200-rpm

● 320-GB, 7200-rpm

Fixed optical drives Supports the following 12.7-mm SATA optical drives:

● DVD-ROM

● DVD+/-RW SuperMulti DL

● Blu-ray ROM DVD+/-RW SuperMulti DL

 Supports no optical drive option

Audio/Visual Integrated dual-array microphone (webcam models only)

 Stereo speakers (2)

 Integrated webcam (720p HD)

 Headphone and microphone jacks

 IDT 92HD87

Ethernet Realtek RTL8151FH-CG 10/100/1000

 S3/S4/S5 wake on LAN (AC mode only)

 Ethernet cable not included

Wireless Integrated WLAN options by way of wireless module:

 Two WLAN antennas built into display assembly

 Supports “no WLAN” option
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Category Description

 Supports the following WLAN formats:

● Ralink 802.11 b/g/n 1×1

● Atheros 802.11 b/g/n 1×1

● Atheros 802.11 b/g/n + BT Combo

● Broadcom 802.11 b/g/n + BT Combo

● Intel 802.11 b/g/n + BT Combo

● Intel 802.11 a/b/g/n 2×2 + BT Combo

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Bluetooth 4.0 only supported by combo card

External media card 6-in-1 Digital Media Reader Slot

Ports Audio-in (stereo microphone)

 Audio-out (stereo headphone)

 RJ-45 (Ethernet, includes link and activity lights)

 USB 3.0 (2)

 USB 2.0 (2)

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug/
unplug with auto-detect)

 HDMI

 Multi-pin AC port

Keyboard/pointing devices Full-sized keyboard with numeric keypad

 Touchpad includes: supports 2-way scroll with legend, taps enabled by default, 2-
finger scrolling and zoom enabled by default

Power requirements 90-W Smart AC adapter with localized cable plug support (3-wire plug with ground
pin):

 In-line cavity, 8-cell, 73-Wh Li-ion battery

Security Integrated fingerprint reader

 Intel AT support

 Support Kensington security lock

 Support no fingerprint reader option

Operating system Preinstalled:

 Windows 7 Professional 64 with Microsoft Basics

 Windows 7 Professional 32 with Microsoft Basics (Japan only)

 Windows 7 Home Premium 64 with Microsoft Basics

 Novell™: SuSE Linux™ – SLED 11, 64-bit, SP2

 FreeDOS
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Category Description

 Preinstalled with Microsoft Office:

 Windows 7 Home Basic 64 with Microsoft Office 2010 Starter (not for Japan)

 Windows 7 Home Basic 64 with Microsoft Office 2010 Starter – EDGI

 Windows 7 Home Basic 64 with Microsoft Office 2010 Professional (Japan only)

 Windows 7 Professional 64 with Microsoft Office 2010 Starter MSNA

 Windows 7 Professional 64 with Microsoft Office 2010 Starter EDGI

 Windows 7 Professional 64 with Microsoft Office 2010 Starter (not for Japan)

 Windows 7 Professional 64 with Microsoft Office 2010 Personal (Japan only)

 Windows 7 Professional 64 with Microsoft Office 2010 Home & Business (Japan only)

 Windows 7 Professional 64 with Microsoft Office 2010 Professional (Japan only)

 Windows 7 Professional 32 with Microsoft Office 2010 Personal (Japan only)

 Windows 7 Professional 32 with Microsoft Office 2010 Home & Business (Japan only)

 Windows 7 Professional 32 with Microsoft Office 2010 Professional (Japan only)

 Windows 7 Home Premium 64 with Microsoft Office 2010 Starter EDGI

 Windows 7 Home Premium 64 with Microsoft Office 2010 Starter (not for Japan)

 Windows 7 Home Premium 64 with Microsoft Office 2010 Personal (Japan only)

 Windows 7 Home Premium 64 with Microsoft Office 2010 Home & Business (Japan
only)

 Windows 7 Home Premium 64 with Microsoft Office 2010 Professional (Japan only)

Restore Media:

 Windows 7 Professional 64

 Windows 7 Professional 32

 Windows 7 Home Premium 64

 Windows 7 Home Basic 64

 DRDVD Windows 7

 Web-only support:

 Windows XP Professional (Discrete graphic drive not supported)

 Windows 7 Home Basic 32

 Windows 7 Home Premium 32

 Windows 7 Professional 32

 Certified:

 Microsoft WHQL

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)
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Category Description

 Hard drive

 Memory module

 Optical drive

 WLAN module

 Keyboard
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2 External component identification

Display

Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(2) Internal microphone(s) (1 or 2 depending on
model)

Record sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records video and captures still photographs.

To use the webcam, select Start > All Programs > Music,
Photos and Videos>WebCam Companion.
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Component Description

(5) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Top

TouchPad

Component Description

(1)  TouchPad on/off button Turns the TouchPad on and off.

(2)  TouchPad zone Moves the pointer and selects or activates items on the
screen.

(3)  Left TouchPad button Functions like the left button on an external mouse.

(4)  Right TouchPad button Functions like the right button on an external mouse.
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Lights

Components Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2)  Caps lock light On: Caps lock is on.

(3) Web browser light ● On: The computer is on.

● Off: The computer is off, in Suspend mode, or in
Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on

● Amber: All wireless devices are off.

(5)  TouchPad light ● Amber: The TouchPad is off.

● Off: TouchPad is on.
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Buttons and fingerprint reader (select models only)

Component Description

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press the
button briefly to exit Sleep.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Microsoft®
Windows® shutdown procedures are ineffective, press and
hold the power button down for at least 5 seconds to turn off
the computer.

CAUTION: Pressing and holding down the power button
will result in the loss of unsaved information.

To learn more about your power settings:

● Select Start > Control Panel > System and
Security > Power Options.

● Refer to the HP Notebook Reference Guide.

(2)  Speakers (2) Produce sound.

(3) Web browser button Opens the default Web browser.
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Component Description

(4) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

(5)  Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.

Keys

Component Description

(1)  esc key Displays system information when pressed in combination
with the fn key.

(2)  fn key Executes frequently used system functions when pressed
in combination with a function key, the num lk key, the esc
key, or other keys.

(3) Windows logo key Displays the Windows Start menu.

(4)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Windows applications key Displays a shortcut menu for items beneath the cursor.

(6)  num lk key Alternates between the navigational and numeric functions
on the integrated numeric keypad.

(7)  Integrated numeric keypad Can be used like an external numeric keypad.
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Front

Component Description

(1) Drive light ● White: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

NOTE: For information on HP 3D DriveGuard, refer
to the HP Notebook Reference Guide.

(2)  Media Card Reader Supports the following digital card formats:

● Memory Stick PRO

● Memory Stick PRO Duo (needs an adapter)

● MultiMediaCard (MMC)

● MultiMediaCardplus (MMC+)

● Secure Digital (SD) Card

● Secure Digital High Capacity (SDHC) Card

● Secure Digital Extra Capacity (SDXC) Card

(3) Audio-out (headphone) jack Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.
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Left

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)  Power connector Connects an AC adapter.

(3) AC adapter/battery light ● White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

● Amber: The computer is connected to external power
and the battery is charged from 0 to 90 percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: The battery is fully charged.

(4)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) RJ-45 (network) jack Connects a network cable.

(7) HDMI port Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or audio
device.

(8) USB 3.0 ports (2) Connect optional USB devices. For more information about
USB devices, see the HP Notebook Reference Guide.
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Right

Component Description

(1) USB 2.0 ports (2) Connect optional USB devices. For more information about
USB devices, see the HP Notebook Reference Guide.

(2)  Optical drive (select models only) Reads an optical disc.

NOTE: On select models, the optical drive also writes to
an optical disc.

(3)  Optical drive light (select models only) ● On: The optical drive is being accessed.

● Off: The optical drive is idle.

(4)  Optical drive eject button (select models
only) 

Releases the optical drive disc tray.
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Bottom

Component Description

(1) Battery and service door release latches ● Releases the battery from the battery bay by sliding
the release latches one time.

● When the battery has been removed from the battery
bay, releases the service door from the computer by
sliding the release latches a second time.

(2)  Battery bay Holds the battery.

(3) Service door Protects the hard drive bay, the wireless LAN (WLAN)
module slot, the WWAN module slot, and the memory
module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore computer
functionality, and then contact technical support through
Help and Support.

(4)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

Service tag 15



Computer major components

Item Description Spare part number

(1) Display panel, 43.9-cm (17.3-inch), HD+, anti-glare, with webcam 684631-001
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Item Description Spare part number

(2) Keyboard (includes cable)

NOTE: For a detailed list of available keyboards, see Sequential part number listing
on page 23.

684632-xxx

(3) Top cover (includes touchpad assembly)  

 With a fingerprint reader (includes fingerprint reader assembly) 684616-001

 Without a fingerprint reader 684617-001

(4) Audio board 683475-001

(5) Function board/Power button board assembly (includes cables) 684613-001

(6) Fingerprint reader assembly (includes cable, bracket, and screw) 684610-001

(7) RTC battery 683502-001

(8) System board (includes replacement thermal material)  

 1-GB discrete graphics memory 683493-001

 2-GB discrete graphics memory 683494-001

 1-GB of discrete graphics memory for use in Japan 696336-001

(9) Speaker assembly 684615-001

(10) Hard drive extension board 689655-001

(11) Optical drive extension board 689656-001

(12) Latch Kit (includes left and right latches, knob, and spring) 684635-001

(13) Battery, Li-ion, 8-cell (73 WHr, 2.55 Ah) 633807-001

(14) Base enclosure 684608-001

(15) WLAN module

 Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

 Intel Centrino Wireless-N 2230 670290-001

 Intel Centrino Advanced-N 6235 670292-001

 Ralink WLAN Ralink Ripple3 RT5390F_802.11 b/g/n 1x1 PCIe HMC 670691-001

 Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001

(16) Memory modules (PC3-12800, 1600-MHz, DDR3)

 4-GB 641369-001

 2-GB 652972-001

(17) Processor (includes thermal material)  

 Intel Core i7 processor, Quad Core  

 3612QM, 2.1-GHz processor with 6-MB L3 cache 680647-001

 Intel Core i5 processors, Dual Core  

 3360M, 2.8-GHz processor with 3-MB L3 cache (includes thermal grease) 681953-001
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Item Description Spare part number

 3320M, 2.6-GHz processor with 3-MB L3 cache (includes thermal grease) 681952-001

 2450M, 2.5-GHz processor with 3-MB L3 cache (includes thermal grease) 676359-001

 Intel Core i3 processors, Dual Core  

 3110M, 2.3-GHz processor with 3-MB L3 cache (includes thermal grease) 682417-001

 2370M, 2.4-GHz processor with 3-MB L3 cache (includes thermal grease) 677152-001

 2350M, 2.3-GHz processor with 3-MB L3 cache (includes thermal grease) 653340-001

 Intel Pentium processor, Dual Core  

 B980, 2.4-GHz, with 2-MB L3 cache 692428-001

 B970, 2.3-GHz, with 2-MB L3 cache 676785-001

 Intel Celeron processor  

 B840, 1.9-GHz, with 2-MB L3 cache 664663-001

(18) Heat sink (includes replacement thermal material) 689657-001

(19) Fan 689658-001

(20) Optical drive (includes bracket, bezel, and screws)

 DVD±RW Double-Layer Drive 684629-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 684630-001

(21) Hard drive  

 750-GB, 7200-rpm 633252-001

 750-GB, 5400-rpm 634250-001

 640-GB, 5400-rpm 669300-001

 500-GB, 7200-rpm, 634925-001

 320-GB, 7200-rpm 641672-001

(22) Bottom door 684634-001
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Display components

Item Description Spare part number

(1) Display bezel 684609-001

(2) Webcam module for use in all models 683508-001

 Display Hinge Kit 684612-001

(3) ● Display hinge covers  

(4) ● Display hinges  

 ● Screw covers (not illustrated)  

Plastics Kit

Item Description Spare part number

 Plastics Kit 684614-001

(1) Optical drive protective insert

(2) Secure Digital card protective insert
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Cable Kit

Item Description Spare part number

 Cable Kit 684633-001

(1) Battery connector cable

(2) Power connector cable

(3) Audio cable

(4) USB connector cable
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Mass storage devices

 Description Spare part number

(1) Hard drives 

 750-GB, 7200-rpm 633252-001

 750-GB, 5400-rpm 634925-001

 640-GB, 5400-rpm 669300-001

 500-GB, 7200-rpm 634925-001

 320-GB, 7200-rpm 641672-001

 Hard Drive Hardware Kit (includes hard drive bracket and screws; not illustrated) 683488-001

(2) Optical drives (include bezel, bracket, and screws)

 DVD±RW Double-Layer Drive 684629-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 684630-001
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Miscellaneous parts

Description Spare part number

AC adapters

90-W AC adapter 693712-001

90-W AC adapter for use in India and the People's Republic of China 693713-001

Power cords:

For use in Australia and New Zealand 490371-011

For use in the People's Republic of China 490371-AA1

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031

For use in the United States 490371-001

Rubber Kit (includes feet and display bezel screw covers) 684627-001

Screw Kit 684628-001

Mouse, optical, 2-button 390632-001

Notebook combination lock 591699-001

HP keyed cable lock 626729-001

HP optical travel mouse 434594-001

Professional slim, top load case 592923-001

Basic messenger bag 501505-001
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Sequential part number listing
CSR flag designations:

A = Mandatory

B = Optional

C = Service technician recommended

N = Non-user replaceable

Spare part
number

CSR
flag

Description

390632-001 A Mouse, optical, 2-button

434594-001 A HP optical travel mouse

490371-001 A Power cord for use in North America

490371-011 A Power cord for use in Australia and New Zealand

490371-021 A Power cord for use in Europe, the Middle East, and Africa

490371-031 A Power cord for use in the United Kingdom

490371-111 A Power cord for use in Switzerland

490371-291 A Power cord for use in Japan

490371-AA1 A Power cord for use in the People's Republic of China

490371-AB1 A Power cord for use in Taiwan

490371-AD1 A Power cord for use in South Korea

490371-AR1 A Power cord for use in South Africa

490371-BB1 A Power cord for use in Israel

490371-D61 A Power cord for use in India

501505-001 A Basic messenger bag

591699-001 A Notebook combination lock

592923-001 A Professional slim, top load case

626729-001 A HP keyed cable lock

633252-001 A 750-GB, 7200-rpm hard drive

633807-001 A 8-cell, 73 WHr, 2.8 Ah Li-ion battery

634250-001 A 750-GB, 5400-rpm hard drive

634925-001 A 500-GB, 7200-rpm hard drive

641369-001 A 4-GB memory module (PC3-12800, 1600-MHz, DDR3)

641672-001 A 320-GB, 7200-rpm hard drive

652972-001 A 2-GB memory module (PC3-12800, 1600-MHz, DDR3)

653340-001 N Intel Core i3 processor, 2350M, 2.3-GHz processor, 3-MB L3 cache (includes thermal material)
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Spare part
number

CSR
flag

Description

655795-001 A Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

657325-001 A Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

664663-001 N Intel Celeron B840 processor, 1.9-GHz processor, 3-MB L3 cache (includes thermal material)

669300-001 A 640-GB, 5400-rpm hard drive

670290-001 A Intel Centrino Wireless-N 2230 WLAN card

670292-001 A Intel Centrino Advanced-N 6235 WLAN card

670691-001 A Ralink WLAN Ralink Ripple3 RT5390F_802.11 b/g/n 1x1 PCIe HMC

675794-001 A Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter

676359-001 N Intel Core i5 processor, 2450M, 2.5-GHz, 3-MB L3 cache (includes thermal material)

676785-001 N Intel Pentium B970 processor, 2.3-GHz, 2-MB L3 cache (includes thermal material)

677152-001 N Intel Core i3 processor, 2370M, 2.4-GHz, 3-MB L3 cache (includes thermal material)

680647-001 N Intel Core i7 processor, 3612QM, 2.1-GHz, 6-MB L3 cache (include thermal material)

681952-001 N Intel Core i5 processor, 3320M, 2.6-GHz, 3-MB L3 cache (include thermal material)

681953-001 N Intel Core i5 processor, 3360M, 2.8-GHz, 3-MB L3 cache (include thermal material)

682417-001 N Intel Core i3 processor, 3110M, 2.3-GHz, 3-MB L3 cache (include thermal material)

683475-001 N Audio board

683488-001 A Hard Drive Hardware Kit (includes bracket and screws)

683493-001 N System board for use in models with 1-GB discrete graphics (includes thermal material)

683494-001 N System board for use in models with 2-GB discrete graphics (includes thermal material)

683502-001 A RTC battery

683508-001 N Webcam module

684608-001 N Base enclosure

684609-001 N Display bezel for use in models with a webcam

684610-001 N Fingerprint reader assembly (includes cable, bracket, and screws)

684612-001 N Display Hinge Kit (includes left and right hinges, hinge covers, and screws)

684613-001 N Function board/power button board assembly (includes cable)

684614-001 N Plastics Kit (includes optical drive protective insert and Secure Digital card protective insert)

684615-001 N Speaker assembly

684616-001 N Top cover for use in models with a fingerprint reader (includes fingerprint reader board and
touchpad assembly)

684617-001 N Top cover for use in models without a fingerprint reader (includes touchpad assembly)

684627-001 N Rubber Kit (includes feet and display bezel screw covers)

684628-001 N Screw Kit

684629-001 A DVD±RW Double-Layer Drive (includes bezel, bracket, and screws)
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Spare part
number

CSR
flag

Description

684630-001 A Blu-ray ROM DVD±RW SuperMulti DL Drive (includes bezel, bracket, and screws)

684631-001 N 43.9-cm (17.3-inch) display assembly, HD+ anti-glare, with webcam

684632-001 A Keyboard for use in the United States 

684632-031 A Keyboard for use in the United Kingdom

684632-041 A Keyboard for use in Germany

684632-051 A Keyboard for use in France

684632-061 A Keyboard for use in Italy

684632-071 A Keyboard for use in Spain

684632-131 A Keyboard for use in Portugal

684632-141 A Keyboard for use in Turkey

684632-151 A Keyboard for use in Greece

684632-171 A Keyboard for use in Saudi Arabia

684632-211 A Keyboard for use in Hungary

684632-251 A Keyboard for use in Russia

684632-261 A Keyboard for use in Bulgaria

684632-271 A Keyboard for use in Romania

684632-281 A Keyboard for use in Thailand

684632-291 A Keyboard for use in Japan

684632-A41 A Keyboard for use in Belgium

684632-AB1 A Keyboard for use in Taiwan

684632-AD1 A Keyboard for use in South Korea

684632-B31 A Keyboard for use in the Netherlands and Europe

684632-BA1 A Keyboard for use in Slovakia

684632-BB1 A Keyboard for use in Israel

684632-BG1 A Keyboard for use in Switzerland

684632-D61 A Keyboard for use in India

684632-DD1 A Keyboard for use in Iceland

684632-DH1 A Keyboard for use in the Netherlands

684632-FL1 A Keyboard for use in the Czech Republic

684632-FP1 A Keyboard for use in the northern Africa

684633-001 A Cable Kit (see Cable Kit on page 20 for more Cable Kit spare part information)

684634-001 A Bottom door

684635-001 N Latch Kit

689655-001 N Hard drive connector
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Spare part
number

CSR
flag

Description

689656-001 N Optical drive connector

689657-001 N Heat sink (includes thermal material)

689658-001 N Fan

692428-001 N Intel Pentium B980 processor, 2.4-GHz, 2-MB L3 cache (includes thermal material)

693712-001 A 90-W AC adapter

693713-001 A 90-W AC adapter for use in India and the People's Republic of China

696336-001 N System board for use in Japan in models with 1-GB of discrete graphics memory
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.
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Battery

Description Spare part number

8-cell, 73 WHr, 2.8 Ah Li-ion battery 633807-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface.

2. Slide the battery release latches (1) to release the battery.

NOTE: You can slide the battery release latches simultaneously or one at a time.

3. Tilt the battery upward (2) to remove it from the battery bay (3).

Install the battery by inserting it into the battery bay until you hear a click.
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Bottom door

Description Spare part number

Bottom door 684634-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

Remove the bottom door:

1. Position the computer upside-down on a flat surface with the battery bay toward you.

2. Remove the locking screw (if installed) (1) and slide the bottom door release latches (2) to
release the door.

3. Slide the door toward the front of the computer (3), and then lift the door off the computer (4).

Reverse the removal procedures to install the bottom door.
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Using the optional security screw

Use the optional security screw to lock the service door to the bottom of the computer. When not in
use the security screw can be stored inside the battery bay.

Remove the battery:

To use the security screw:

1. Remove the battery.

2. Remove the security screw from inside the battery bay (1) and insert it (2) to lock the service
door in place.
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Optical drive

NOTE: All optical drive spare part kits include an optical drive bezel, bracket, and screws.

Description Spare part number

DVD±RW Double-Layer Drive 684629-001

Blu-ray ROM DVD±RW SuperMulti DL Drive 684630-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the bottom door (see Bottom door on page 34).

Remove the optical drive:

1. Position the computer upside-down.

2. Remove the Phillips PM2.5×6.0 screw (1) that secures the optical drive to the computer.

3. Push the optical drive tab (2) to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

Reverse this procedure to install an optical drive.
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Hard drive

Description Spare part number

750-GB, 7200-rpm hard drive 633252-001

750-GB, 5400-rpm hard drive 634250-001

640-GB, 5400-rpm hard drive 669300-001

500-GB, 7200-rpm hard drive 634925-001

320-GB, 7200-rpm hard drive 641672-001

Hard Drive Hardware Kit (includes hard drive bracket and screws) 683488-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the bottom door (see Bottom door on page 34).

Remove the hard drive:

1. Position the computer upside-down with the front toward you.

2. Remove the four Phillips PM2.5×3.0 screws (1) that secure the hard drive to the computer.
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3. Pull the Mylar tab on the hard drive (2) towards the side of the computer to disengage the hard
drive from the connector, and then lift the hard drive out of the hard drive bay.

4. If it is necessary to replace the hard drive cover, lift the Mylar tab to unlock it.

5. Remove the four Phillips PM3.0×3.0 hard drive cover screws (1) that secure the cover to the
hard drive.
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6. Lift the top of the Mylar cover (2) from the drive, and then remove the cover from the hard drive
(3).

Reverse this procedure to reassemble and install the hard drive.
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Memory modules

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of the
computer.

Description Spare part number

2-GB (PC3-12800, 1600-MHz, DDR3) 652972-001

4-GB (PC3-12800, 1600-MHz, DDR3) 641369–001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then click
Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the bottom door (see Bottom door on page 34).

Remove the memory module:

1. Position the computer upside-down.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory sockets. The top socket houses the expansion
memory module and the bottom socket houses the primary memory module. The removal
procedure is the same for both memory sockets.

Reverse this procedure to install a memory module.
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WLAN/Bluetooth combo card

The computer uses a card that provides both WLAN and Bluetooth functionality.

Description Spare part number

Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Intel Centrino Wireless-N 2230 670290-001

Intel Centrino Advanced-N 6235 670292-001

Ralink WLAN Ralink Ripple3 RT5390F_802.11 b/g/n 1x1 PCIe HMC 670691-001

Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the bottom door (see Bottom door on page 34).

Remove the WLAN module:

1. Position the computer upside-down.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN
antenna cable connects to the middle terminal on the WLAN module.

3. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following
illustration.

Reverse this procedure to install the WLAN module.

44 Chapter 4   Removal and replacement procedures



Keyboard

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 23.

Description Spare part number

Keyboard 684632-xxx

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the bottom door (see Bottom door on page 34).

Remove the keyboard:

1. Position the computer upside-down with the front toward you.

2. Remove the three Phillips PM2.5×6.0 screws that secure the keyboard to the computer.

3. Position the computer upright with the front toward you.

4. Open the computer as far as possible.

5. Slide the keyboard downward toward the palm rest (1).
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6. Lift the top of the keyboard at an angle (2), and then pull the keyboard up to remove it from the
palm rest (3).

NOTE: Only pull the keyboard up enough to release it from the computer and flip it over onto
the palm rest. Under the keyboard, the cable is connected to the system board.

7. Rotate the keyboard until it rests on the palm rest (1), and then disconnect the keyboard cable
by lifting the keyboard connector latch (2), and then disconnecting the keyboard cable from the
system board (3).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

NOTE: Top cover spare part kits include the touchpad assembly.

Description Spare part number

Top cover with a fingerprint reader (includes fingerprint reader assembly) 684616-001

Top cover without a fingerprint reader 684617-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Memory modules (see Memory modules on page 41)

c. Keyboard (see Keyboard on page 45)

Remove the top cover:

1. Position the computer upside-down with the front toward you.
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2. Remove the following covers and screws that secure the top cover to the computer:

(1) 5 rubber screw covers

(2) 13 Torx T8M2.5×8.0 screws
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3. Remove the following screws that secure the top cover to the computer as follows:

(1) 3 Phillips broadhead PM2.0×3.0 screws from the battery bay

(2) 2 Phillips PM2.0×4.0 screws from the battery bay

(3) 2 Phillips PM2.0×3.0 screws from the optical drive bay

4. Position the computer upright and open it as far as possible.

5. Remove the four Torx T8M2.5×8.0 screws that secure the top cover to the computer.
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6. Disconnect the power button board/function board cable (1) and the fingerprint reader board
cable (2) from the system board.

7. Lift the front of the top cover slightly to gain access to the cable and connector underneath (1).

8. Disconnect the audio board cable (2) from the system board.
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9. Lift the top of the top cover (1), and then remove the top cover from the computer (2).

Reverse this procedure to install the top cover.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable, bracket, and screws) 684610-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the fingerprint reader board:

1. Position the top cover upside-down with the front toward you.

2. Remove the Phillips PM2.0×3.0 screw (1) that secures the fingerprint reader board bracket to
the top cover.

3. Slide the bracket toward the bottom of the top cover (2), and then lift it off the top cover (3).
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4. Remove the fingerprint reader board and cable assembly from the top cover (4).

Reverse this procedure to install the fingerprint reader board.
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Function board/Power button board assembly

Description Spare part number

Function board/Power button board assembly (includes cable) 684613-001

Before removing the function board and power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the function board/power button board assembly:

1. Position the top cover upside-down with the front toward you.

2. Remove the two Phillips PM2.0×3.0 screws (1) that secure the function (quick) board to the top
cover and the two Phillips PM2.0×3.0 screws (1) that secure the power button board to the top
cover.

3. Lift the function board from the top cover (2).
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4. Lift the power button board from the top cover (3).

Reverse this procedure to install the function board power button board assembly.

USB connector assembly

The USB connector assembly is included in the Cable Kit, spare part number 684633-001.

Before removing the USB connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the USB connector assembly:

1. Position the computer upright.

2. Disconnect the cable from the system board (1).

3. Remove the cables from the routing path (2).
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4. Remove the two Phillips PM2.5×4.0 screws (3) that secure the USB connector to the computer.

5. Remove the USB connector assembly from the computer (4).

Reverse this procedure to install the USB connector assembly.
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Fan

Description Spare part number

Fan 689658-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the fan:

1. Position the computer upside down.

2. Disconnect the fan cable from the system board.

3. Position the computer upright.

4. Remove the Phillips PM2.5×4.0 screw (1) that secures the fan to the system board.
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5. Remove the fan from the computer (2).

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.

Speaker assembly

Description Spare part number

Speaker assembly 684615-001

NOTE: You must remove the speakers to access the screws that secure the display.

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the speaker assembly:

1. Position the computer upright with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the speaker cable from the system board (1).

4. Remove the four Phillips PM2.5×4.0 screws (2) that secure the speakers to the computer.

5. Remove the speakers from the computer (3).

Reverse this procedure to install the speaker assembly.
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Audio board

Description Spare part number

Audio board 683475-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

Remove the audio board:

1. Position the computer upright with the front toward you.

2. Disconnect the smaller touchpad button cable (1).

3. Remove the Phillips PM2.0×3.0 screw (2) that secures the audio board to the computer.

4. Rotate the top of the board upward, pull the board away from the connectors (to remove them
from top cover holes), and then lift the board off the top cover (3).

60 Chapter 4   Removal and replacement procedures



Reverse this procedure to install the audio board.

Power cable

The power cable is included in the Cable Kit, spare part number 684633-001.

Before removing the power cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Keyboard (see Keyboard on page 45)

c. Top cover (see Top cover on page 47)

d. Speaker (see Speaker assembly on page 58)

e. Fan (see Fan on page 57)

Remove the power cable:

1. Position the computer upright.

2. Disconnect the cable from the bottom of the system board (1).

3. Lift the power cable assembly from the computer (2).

Reverse this procedure to install the power cable.
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Battery cable

The battery cable is included in the Cable Kit, spare part number 684633-001.

Before removing the battery cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Fan (see Fan on page 57)

Remove the battery cable:

1. Position the computer upright and open as far as possible.

2. Remove the cable from the system board connector (1).

3. Remove the two Phillips PM2.0×4.0 screws that secure the battery cable to the computer (2).
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4. Lift the battery cable from the computer (3).

Reverse this procedure to install the battery cable.

System board

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

System board for use in models with 1-GB of discrete graphics memory 683493-001

System board for use in models with 2-GB of discrete graphics memory 683494-001

System board for use in Japan in models with 1-GB of discrete graphics memory 696336-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. Keyboard (see Keyboard on page 45)
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e. Top cover (see Top cover on page 47)

f. Speaker assembly (see Speaker assembly on page 58)

g. Fan (see Fan on page 57)

h. Battery connector cable (see Battery cable on page 62)

When replacing the system board, be sure to remove the following components from the defective
system board and install on the replacement system board:

● Memory module (see Memory modules on page 41)

● WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

● Processor (see Processor on page 73)

● Optical drive extension board (see Optical drive extension board on page 68)

● Hard drive extension board (see Hard drive extension board on page 70)

Remove the system board:

1. Position the computer upright with the front toward you.

2. Disconnect the power cable (1), display cable (2), and the USB connector cable (3) from the
system board.

3. If necessary, disconnect the battery connector cable from the system board (1).

4. Remove the four Phillips PM2.5×4.0 screws (2) that secure the system board to the computer.
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5. Lift the right side of the system board up at an angle (3).

6. Pull the system board up and toward the right to remove it from the computer.

Reverse this procedure to install the system board.
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RTC battery

Description Spare part number

RTC battery 683502-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. Keyboard (see Keyboard on page 45)

e. Top cover (see Top cover on page 47)

f. Speaker assembly (see Speaker assembly on page 58)

g. Fan (see Fan on page 57)

h. Battery connector cable (see Battery cable on page 62)

i. System board (see System board on page 63)

Remove the RTC battery:

1. Position the system board upside-down.

2. Disconnect the RTC battery connector from the system board (1).
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3. Lift the battery from the system board (2).

Reverse this procedure to install the RTC battery.
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Optical drive extension board

Description Spare part number

Optical drive extension board 689656-001

Before removing the optical drive extension board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Speaker assembly (see Speaker assembly on page 58)

h. Fan (see Fan on page 57)

i. System board (see System board on page 63)

Remove the optical drive extension board:
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▲ Pull the optical drive extension board straight away from the side of the system board.

Reverse this procedure to install the optical drive extension board.
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Hard drive extension board

Description Spare part number

Hard drive extension board 689655-001

Before removing the hard drive extension board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Speaker assembly (see Speaker assembly on page 58)

h. Fan (see Fan on page 57)

i. System board (see System board on page 63)

Remove the hard drive extension board:
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▲ Pull the hard drive extension board straight away from the side of the system board.

Reverse this procedure to install the hard drive extension board.
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Heat sink

All heat sink spare part kits include replacement thermal material.

Description Spare part number

Heat sink 689657-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Speaker assembly (see Speaker assembly on page 58)

h. Fan (see Fan on page 57)

i. System board (see System board on page 63)

Remove the heat sink:

1. Position the system board upside-down.

2. To remove the discrete heat sink, in the order indicated on the heat sink, loosen the six captive
Phillips screws (1) that secure the heat sink to the system board.
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3. Lift the heat sink from the system board (2).

NOTE: Thoroughly clean thermal material from the surfaces of the system board components (1)(3)
and the heat sink (2)(4) each time you remove the heat sink. All heat sink and processor spare part
kits include thermal material.

Reverse this procedure to install the heat sink.

Processor

NOTE: All processor spare part kits include replacement thermal material.
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Description Spare part number

Intel Core i7 processor, Quad Core  

3612QM, 2.1-GHz processor with 6-MB L3 cache 680647-001

Intel Core i5 processors, Dual Core  

3360M, 2.8-GHz processor with 3-MB L3 cache (includes thermal grease) 681953-001

3320M, 2.6-GHz processor with 3-MB L3 cache (includes thermal grease) 681952-001

2450M, 2.5-GHz processor with 3-MB L3 cache (includes thermal grease) 676359-001

Intel Core i3 processors, Dual Core  

3110M, 2.3-GHz processor with 3-MB L3 cache (includes thermal grease) 682417-001

2370M, 2.4-GHz processor with 3-MB L3 cache (includes thermal grease) 677152-001

2350M, 2.3-GHz processor with 3-MB L3 cache (includes thermal grease) 653340-001

Intel Pentium processor, Dual Core  

B980, 2.4-GHz, with 2-MB L3 cache 692428-001

B970, 2.3-GHz, with 2-MB L3 cache 676785-001

Intel Celeron processor  

B840, 1.9-GHz, with 2-MB L3 cache 664663-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Fan (see Fan on page 57)

h. System board (see System board on page 63)

i. Heat sink (see Heat sink on page 72)
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Remove the processor:

1. Position the system board upside-down.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle embossed on
the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Latch assembly

NOTE: The Latch Kit includes the left and right latches, knob, screws, and spring.

Description Spare part number

Latch Kit 684635-001

Before removing the latch assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. Hard drive (see Hard drive on page 38)

c. Optical drive (see Optical drive on page 36)

d. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

e. Keyboard (see Keyboard on page 45)

f. Top cover (see Top cover on page 47)

g. Fan (see Fan on page 57)

h. System board (see System board on page 63)

NOTE: The latch mechanism includes a small spring. Note the location of the spring.

Remove the latch assembly:

1. Position the computer upright and open as far as possible.

2. Remove the spring (1) from the tab on the base enclosure (2).
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3. Slide the latch mechanism toward the left (3), and then lift it from the computer (4).

Reverse this procedure to install the latch assembly.
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Display assembly

All display assemblies include WLAN antenna transceivers and cables.

For a list of individual display spare parts, see Display components on page 19.

Description Spare part number

Display assembly, 43.9-cm (17.3-inch), HD+, anti-glare, with webcam 684631-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the following components:

a. Bottom door (see Bottom door on page 34).

b. WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 43)

c. Keyboard (see Keyboard on page 45)

d. Top cover (see Top cover on page 47)

e. Speaker assembly (see Speaker assembly on page 58)

Remove the display assembly:

1. Position the computer upside down.
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2. Remove the WLAN antennas from the routing path (1) and tabs (2) on the bottom of the
computer.

3. Place the computer upright and open as far as possible.

4. Pull the antennas through the hole that routes to the bottom of the computer.

5. Remove the WLAN antennas from the tabs (1) and the routing path (2) on the top of the
computer.

6. Remove the four Torx T8M2.5×8.0 screws (1) from the display hinges.
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7. Lift the display assembly straight up and remove it (2).

CAUTION: When installing the display assembly, be sure that the wireless antenna cables are
routed and arranged properly.

Failure to properly route the antennas can result in degradation of the computer's WLAN
performance.

80 Chapter 4   Removal and replacement procedures



8. If you need to remove the hinge covers from the display hinges, pull the hinges straight up and
off the display to remove them.

Display hinge covers are available in the Display Hinge Kit using spare part number
684612-001.

9. To replace the display bezel, remove the two rubber screw covers (1) and the two Phillips
PM2.5×5.0 screws (2) in the bottom corners of the display bezel.
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10. Flex the top (1) of the bezel, the inside edges of the left and right sides (2), and then the bottom
(3) of the bezel until it disengages from the display enclosure.

11. Remove the display bezel (4).

The display bezel is available using spare part number 684609-001.
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12. If it is necessary to replace the webcam module, disconnect the cable from the module (1), and
then gently pull the module away from the double-sided tape on the display enclosure (2).

The webcam module is available using spare part number 683508-001.

13. If it is necessary to replace the display hinges, remove the six Phillips PM2.5×4.0 screws that
secure the display hinges and panel to the display enclosure.

14. Remove the display hinges and panel from the display enclosure.
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15. Disconnect the display panel cable by rotating the display enclosure (1), lifting the tape (2) that
covers the connector, and disconnecting the cable from the panel (3).

16. Position the display panel and hinge assembly upright.

17. Remove the three Phillips PM2.0×3.0 screws (1) that secure each display hinge to the display
panel.
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18. Remove the display hinges (2).

Display hinges are available in the Display Hinge Kit using spare part number 684612-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

86 Chapter 5   Computer Setup (BIOS) and Advanced System Diagnostics



To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Updating the BIOS

The next sections describe different ways of updating the BIOS.

Downloading SoftPaqs to update the BIOS

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

To install BIOS updates from the HP website, follow the steps below:

1. Download the SoftPaq from the HP website.

2. Click Run, and then follow the on-screen instructions to update the BIOS.

NOTE: Some download packages contain a file named Readme.txt, which contains information
regarding installing and troubleshooting the file.

BIOS management using system diagnostics

1. Download the SoftPaq from the HP website.

NOTE: Verify that the UEFI system diagnostics is installed on your computer (or USB flash
drive).

2. Click Run, and then click Cancel at the Update/USB bootable dialog box.

3. Navigate to the folder located in c:\swsetup that corresponds to your SoftPaq number.

4. Locate the .bin file in the ROMpaq folder (for example, 68CDD.bin) and then copy it to the
Hewlett-Packard\BIOS\New\ folder in either the HP_Tools partition of the hard drive, or the USB
flash drive.

5. Locate the .sig file in the ROM.cab file and rename it with the same prefix as the .bin file (for
example, 68CDD.sig). Copy the renamed file to the Hewlett-Packard\BIOS\New\ folder in either
the HP_Tools partition of the hard drive, or the USB flash drive.

6. Restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

7. Press f2 to enter Computer Setup.

8. Click BIOS Management from the menu and then select Update BIOS.

Using f10 setup to update the BIOS

1. Download the SoftPaq from the HP website.

NOTE: Verify that the UEFI system diagnostics is installed on your computer (or USB flash
drive).

2. Click Run, and then click Cancel at the Update/USB bootable dialog box.

3. Navigate to the folder located in c:\swsetup that corresponds to your SoftPaq number.

4. Locate the .bin file in the ROMpaq folder (for example, 68CDD.bin) and then copy it to the
Hewlett-Packard\BIOS\New\ folder in either the HP_Tools partition of the hard drive, or the USB
flash drive.
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5. Locate the .sig file in the ROM.cab file and rename it with the same prefix as the .bin file (for
example, 68CDD.sig). Copy the renamed file to the Hewlett-Packard\BIOS\New\ folder in either
the HP_Tools partition of the hard drive, or the USB flash drive.

6. Restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

7. Press f10 to enter Computer Setup.

8. Click Update System BIOS, and then click Accept to update the BIOS.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

BIOS Setup Menu

The tables in this section provide an overview of the BIOS Setup menu options.
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Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about your computer.

● View specification information about the processor,
memory size, and system BIOS.

Security menu

Select To do this

Administrator password Control access to Setup Utility.

Power-on password Control access to your computer.

Diagnostics menu

Select To do this

Primary Hard Disk Self Test Run a quick or comprehensive self-test on the hard drive.

Memory Test Run a diagnostic test on the system memory.

Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.
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You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Length 28.0 cm 11.0 in

Width 41.4 cm 16.3 in

Height (front to rear) 2.9 to 3.6 cm 1.1 to 1.4 in

Weight (equipped with optical drive, 1 DIMM, hard drive,
optical drive, WLAN module, 6 cell battery)

3.1 kg 6.7 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W or 18.5 V dc @ 3.5 A - 65 W

Operating current 4.74 A or 3.5 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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43.9-cm (17.3-in), HD+ display specifications

 Metric U.S.

Active diagonal size 43.9-cm 17.3-in

Resolution 1600x900 (HD+)

Active area 382.08x214.92

PPI 106

Surface treatment Anti-glare or BrightView

Contrast ratio 300:1 (typical) – Anti-glare

500:1 – BrightView

Response time 16 ms

Brightness 200 nits (typical)

Viewing angle SVA

Backlight LED

Luminance uniformity @ 13 points 1.4 (typ), 1.6 (max)

Lifetime (1/2 luminance) 12,000 hours

Color coordinate (white) (0.313, 0.329)

Color tolerance (White) +/- 0.02

Color tolerance (W, R, G, B) +/- 0.03

Color gamut 60% NTSC @ CIE 1931
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Hard drive specifications

 750-GB* 640-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 115 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 2 ms 3 ms 3 ms

Average 11 ms 12 ms 13 ms 13 ms

Maximum 14 ms 22 ms 24 ms 24 ms

Logical blocks 1,465,149,168 1,250,263,728 1,048,576,000 625,141,400

Disc rotational speed 7200 rpm or 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti DL Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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Specification information in Device Manager
Device Manager allows you to view and control the hardware attached to the computer, as well as
provides hardware specification information.

You can also add hardware or modify device configurations using Device Manager.

NOTE: Windows 7 includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

After you open Device Manager, drill-down to a device and double-click it to access its properties.

To access Device Manager in Windows 7:

1. Select Start > Computer > System properties.

2. In the left pane, click Device Manager.

To access Device Manager in Windows XP:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, select View system information.

3. Select Hardware tab > Device Manager.
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7 Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)
by using the installed optical drive (select models only) or an optional external optical drive, or create
system restore points. In case of system failure, you can use the backup files to restore the contents
of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP
Recovery Disc Creator. This recovery media performs a system recovery if the hard drive becomes
corrupted. A system recovery reinstalls the original operating system and the software programs
installed at the factory, and then configures the settings for the programs.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.
Choosing this selection creates a DVD that restores the original operating system and the
software programs installed at the factory.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: Operating system recovery media can be created only once. Thereafter, the option to create
that media will not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk or Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.
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Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after software
setup, you should create system repair discs (select models only) using HP Recovery Disc Creator
and the installed optical drive (select models only) or an optional external optical drive to back up your
system. As you add new software and data files, you should continue to back up your system on a
regular basis to maintain a reasonably current backup. The system repair discs (select models only)
are used to start up (boot) the computer and repair the operating system in case of system instability
or failure. Your initial and subsequent backups allow you to restore your data and settings if a failure
occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of external optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
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Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to
Using a Windows 7 operating system DVD (purchased separately) on page 104.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, refer to Using a Windows 7
operating system DVD (purchased separately) on page 104.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to Using a Windows 7 operating system
DVD (purchased separately) on page 104.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling technical
support. For contact information, refer to the Worldwide Telephone Numbers booklet included with
the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1
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Country/region Accredited agency Applicable note number

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL
mark. UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm2 or 1.25mm2 conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75mm2 conductor size. KTL logo and individual approval number must
be on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mm2 conductor size. Power cord set fittings (appliance coupler, cable,
and wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL
and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3X0.75/1.00mm2 conductor size, with
plug BS 1363/A with BSI or ASTA marks.
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9 Recycling

Battery
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not
dispose of the battery in general household waste. Follow the local laws and regulations in your area
for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at http://
www.hp.com/recycle.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Position the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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TouchPad on/off 7
Web browser 9
wireless 10

C
Cable Kit

contents 20
spare part number 20

cables, service considerations 28
caps lock light, identifying 8
chipset, product description 1
components

bottom 14
display 6
front 11
left side 12
right side 13
top 7

Computer Setup
navigating and selecting 86
restoring factory settings 87

computer specifications 93
connectors, service

considerations 28

D
diskette drive

precautions 28
display assembly

removal 78
spare part numbers 78

display bezel
removal 81
spare part numbers 19

display component recycling 109
display components, spare part

numbers 19
display hinge

removal 84
Display Hinge Kit

spare part numbers 19
display panel

product description 1
display specifications 95
drive light 11
drives

optical 13
preventing damage 28

DVD-ROM Drive
precautions 28

DVD±RW and CD-RW SuperMulti
DL Combo Drive

precautions 28
DVD±RW Double-Layer Drive

spare part number 18, 21, 24,
36

E
electrostatic discharge 29
esc key, identifying 10
Ethernet, product description 2
external media cards, product

description 3
external monitor port 12
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F
f11 recovery 104
fan

removal 57
spare part number 18, 26, 57

fingerprint reader assembly
spare part number 17, 24

fingerprint reader board
removal 52
spare part number 52

fingerprint reader, identifying 10
fn key, identifying 10
function board/power button board

assembly
removal 54
spare part number 17, 54

function keys
identifying 10

G
graphics, product description 1
grounding equipment and

methods 31

H
hard drive

precautions 28
product description 2
removal 38
spare part numbers 18, 21,

23, 24, 38
specifications 96

hard drive connector
spare part number 25

hard drive cover, removal 39
hard drive extension board

removal 70
spare part number 17, 70

Hard Drive Hardware Kit, spare
part number 21, 38

hard drive recovery 104
HDMI port, identifying 12
heat sink

removal 72
spare part number 18, 72

hinge
removal 84

I
integrated numeric keypad,

identifying 10

integrated webcam light,
identifying 6

internal display switch 7
internal microphones, identifying

6

J
jacks

audio-in (microphone) 11
audio-out (headphone) 11
network 12
RJ-45 (network) 12

K
keyboard

product description 3
removal 45
spare part numbers 17, 25, 45

keypad
integrated numeric 10

keys
esc 10
fn 10
function 10
num lk 10
Windows applications 10
Windows logo 10

L
latch assembly

removal 76
spare part number 17, 25, 76

legacy support, USB 86
lights

AC adapter 12
caps lock 8
drive 11
optical drive 13
power 8
TouchPad 8
Web browser 8
webcam 6
wireless 8

M
mass storage devices, spare part

numbers 21
Media Card Reader 11
memory module

product description 1

removal 41
spare part numbers 17, 41

microphone (audio-in) jack
product description 2

model name 1

N
network jack, identifying 12
num lk key, identifying 10

O
operating system, product

description 3
optical drive

precautions 28
product description 2
removal 36
spare part numbers 18, 21, 36
specifications 97, 98

optical drive connector
spare part number 26

optical drive eject button 13
optical drive extension board

removal 68
spare part number 17, 68

optical drive light 13
optical drive protective insert

illustrated 19
optical drive, identifying 13

P
packing guidelines 30
plastic parts 27
pointing device, product

description 3
ports

external monitor 12
HDMI 12
product description 3
USB 12, 13

power button, identifying 9
power cable

removal 61
spare part number 61

power connector cable,
illustrated 20

power connector, identifying 12
power cord

set requirements 106
spare part numbers 22, 23

power light 8
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power requirements, product
description 3

processor
product description 1
removal 73
spare part numbers 17, 73

product description
audio 2
chipset 1
display panel 1
Ethernet 2
external media cards 3
graphics 1
hard drives 2
keyboard 3
memory module 1
microphone 2
operating system 3
optical drives 2
pointing devices 3
ports 3
power requirements 3
processors 1
product name 1
security 3
serviceability 4
webcam 2
wireless 2

product name 1

R
recovery partition 104
release latches

access cover 14
battery 14

removal/replacement
preliminaries 27
procedures 32

restoring the hard drive 104
RJ-45 (network) jack, identifying

12
RTC battery

removal 66
spare part number 17, 24, 66

S
Screw Kit, spare part number 22
Secure Digital card insert,

illustrated
illustrated 19

security cable slot 12
security screw

removal 35
security, product description 3
service considerations 27
service door, identifying 14
service tag 15, 32
serviceability, product

description 4
setup utility

navigating and selecting 86
restoring factory settings 87

slots
security cable 12

speaker assembly
removal 58
spare part number 17, 58

speakers, identifying 9
specifications

Blu-ray Disc ROM with
SuperMulti DVD±R/RW DL
Drive 98

computer 93
display 95
DVD±RW and CD-RW

SuperMulti DL Combo Drive
97

hard drive 96
optical drive 97, 98

static-shielding materials 31
system board

removal 63
spare part numbers 17, 63

system repair disc 100
system restore points 100

T
thermal material, replacement 73
tools required 27
top cover

removal 47
spare part number 17, 47

TouchPad
buttons 7

TouchPad light, identifying 8
TouchPad on/off button 7
TouchPad zone

identifying 7
transporting guidelines 30

U
USB connector assembly

removal 55
spare part number 55

USB connector cable
illustrated 20

USB legacy support 86
USB ports, identifying 12, 13

V
vents, identifying 12, 14

W
Web browser button, identifying 9
Web browser light 8
webcam

product description 2
spare part number 24

webcam light, identifying 6
webcam module

removal 83
spare part number 19

webcam, identifying 6
Windows 7 operating system

DVD 104
Windows applications key,

identifying 10
Windows Backup and Restore

100
Windows logo key, identifying 10
wireless antennas

disconnecting 43
wireless button, identifying 10
wireless light 8
wireless, product description 2
WLAN antennas, identifying 6
WLAN module

spare part numbers 17
WLAN/Bluetooth combo card

removal 43
spare part number 43

workstation guidelines 30
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